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Why GIS in Economics?
I Without GIS the unit of analysis is limited to:

I countries

I administrative districts in some developed countries (NUTS in
Europe, counties in the US)

I some villages in developing countries

I The unit of analysis can be any level of spatial aggregation:

I administrative units across all countries

I all populated territories globally

I locations of ethnic/linguistic groups

I old kingdoms

I arti�cial units
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Why GIS in Economics?

I More credible identi�cation strategies. Examples include:

I account for a plethora of geographic covariates

I Come up with instruments (distance from certain locations, like Mainz
(spread of the printing press) from Wittemberg (spread of Protestantism)

I Conduct spatial RD-design exploiting historical accidents (MIta in Peru,
colonial border drawing in Africa, extent of historical empires in Europe, etc..).

I Explore the level at which the pattern uncovered prevails. Invariance
to spatial aggregation?

I this is where virtual-country speci�cations are useful
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Examples of Data

I Satellite images of:

I Annual Nighttime Lights
I Fires
I Annual changes in forest cover

I Modern/Historical Maps
I Roads, trade routes, empires, kingdoms, administrative units
I Group Boundaries, suitability for various crops (FAO-GAEZ)

I Geocoded Data:
I on Con�ict (ACLED, UCDP)
I Google Searches/Facebook users
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Some Applications

I Burgess et al. (2012) on deforestation in Indonesia

I # of districts in a province increases

I => Each district govt o¢ cial engages in Cournot competition in
selling (illegal) logging permits

I => Deforestation in the province increases
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Novelty of Deforestation Paper

I Getting o¢ cial data on deforestation is both practically and
politically infeasible

I Use satellite image of 250m x 250m pixels images of electromagnetic
radiation strength in 36 bands of spectrum

I Develop algorithm to convert radiation patterns to forest coverage
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Where all Hope is Lost Follow the Light!

I Usually the more interesting questions and certainly the least
understood phenomena concern regions where economic indicators
range from limited to fabricated to simply unavailable. Examples
include:

I con�ict-prone regions,

I non-democratic regimes manufacturing the published statistics,

I low state capacity countries where aggregating information
capabilities are non-existent

I Henderson et al (2012), Michalopoulos and Papaioannou (2013, 2014), Pinkovskiy

(2013), Pinkovskiy and Sala-i-Martin (2014), Depetris Chauvin (2014), etc.
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Ethnic Homelands At Colonization - Murdock 1959
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First Uses of Murdock Map

I Nunn (2008)
I Number of slaves exported from each ethnic homeland aggregated at the country

level and current economic performance

I Nunn and Wantchekon (2012)
I Trust and the number of slaves per ethnic homeland, using as instrument the

distance of one�s ancestral homeland from historic slave ports and looking at

individuals no longer residing in their ethnic homeland

I Fenske (several projects)
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Later Uses of Murdock Map
I Burgess et al. (2013) on roads in Kenya

I Digitize Michelin maps for Kenya since 1961 and track road network
expansion over time to see if the president�s ethnic group sees more
roads built than other groups

I Alsan (2014)

I Uses historic climate data to construct pre-colonial Tse-Tse suitability
for each homeland

I Groups on Tse-Tse prone regions had little use of domesticated
animals => low degree of pre-colonial centralization and low
dependence on intensive agriculture.

I Michalopoulos, Putterman and Weil (2014),
I instrument ancestral dependence on agriculture among individual
residing in urban centers with land�s suitability for agriculture in the
historical ethnic homelands
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Later Uses of Murdock Map

I Michalopoulos and Papaioannou (2013, 2014a, 2014b)
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Precolonial Ethnic Homelands - Light Density 2008

Ü

    Ethnicities' Homelands
    Before Colonization &
Satellite Light Density Today

Traditional Homelands of Ethnicities

Light Density 2007­2008
0.000

0.001 ­ 0.004

0.005 ­ 0.013

0.014 ­ 0.022

0.023 ­ 0.042

0.043 ­ 0.076

0.077 ­ 0.158

0.159 ­ 0.296

0.297 ­ 1.129

1.130 ­ 25.414
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Current National Boundaries and Ethnic Homelands
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Partitioned Groups

Ü

Partitioned Ethnicities
           in Africa

National Boundaries in 1992

Tribal Historical Homelands
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Contemporary National Institutions across Africa

Ü

Rule of Law Across African
  Countries 1996­2004

Rule of Law 1996­2004
­1.912 ­ ­1.459

­1.459 ­ ­0.877

­0.877 ­ ­0.294

­0.294 ­ 0.287

0.287 ­ 0.708
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Digitizing a Map Can be Rewarding!

I As you see digitizing a historical map can take you a very long way...

I Yes it is time consuming but the rewards can be tremendous

I Will spend last half hour of the lectures digitizing a map from
scratch.
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Coordinate Systems

I Earth is a sphere approximately (oblate spheroid)

I But we need to represent its surface on a plane

I Various ways to do so. Each way corresponds to a coordinate
system.

I Very important to know what are the properties of your coordinate
system
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Coordinate Systems

I Why important?

I Properly merge di¤erent spatial datasets

I the iOS 6 application got this wrong

I Properly calculate distances and areas

I Two types: Geographic / Projected
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Coordinate Systems

Geographic Coordinate Systems

I Each location is coded by decimal degrees

I e.g., Mexico City

I Latitude: 19.4284700

I Longitude: -99.1276600

I Not suitable for calculating distances/areas

I 1 degree of latitude: 110.6km at equator, 111.7km at the poles

I 1 degree of longitude: 111.3km at equator, 55.8km at 60 degrees
N/S, 0km in the poles
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Coordinate Systems

Geographic Coordinate Systems

I For calculating long distances between two point locations, however,
it is useful:

I Formula for great circle distance uses degrees in latitude/longitude

I Implemented by Stata ado GLOBDIST

I Many spatial datasets adopt WGS 1984, the most popular
geographic coordinate system
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Coordinate Systems

Projected Coordinate Systems

I Earth surface is projected on a �at plane

I Each location: coded in meters from a certain origin on the
projected surface

I Various projection methods: cylindrical, conic, azimuthal, etc.
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Coordinate Systems

Which Coordinate System?
I Depends on what you want to calculate. (There�s no de�nite answer. Here�s

my suggestion)

I WGS 1984 (or any other geographic coordinate system)

I distance between two locations in large study areas

I UTM good for calculating

I length of polyline features

I distance / area in small regions (within 6 degrees in longitude)

I Any of the �equal area�projections

I such as Sinusoidal, Lambert, Cylindrical, Albers Conic good for
calculating area of large regions

I cf. Which equal area projection to be used only changes the way the world
is shown on a map; all give you the correct area calculation.
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Vector Data

Data Types in GIS

I Spatial data comes in two di¤erent types: Vector & Raster
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Vector Data

Data Types in GIS

I The way to edit data di¤ers a lot between vector and raster.

I Below we read, browse, and intersect spatial datasets in ArcGIS
while learning these di¤erent types of spatial data
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Vector Data

Vector Data

I Each spatial unit in vector data is called a feature

I Three types of a feature:

I polygon

I polyline

I point

I A set of features of the same type: a feature class

I File format in ArcGIS: Shape�le (.shp)
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Data Types in GIS

Vector Data

Vector Data: Polygons

I Represent geographic zones

I Examples include:

I Countries

I Sub-national districts

I Areas in which a certain language is spoken

I Lakes, Islands, etc.
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Data Types in GIS

Vector Data

Let�s Play with Vector Data in ArcMap

I Read Polygons in GIS

I First, launch ArcMap

I Second, drag the shape�les from Catalog Window to Data Frame.

I If you don�t see Catalog Window, click �Windows� in the menu bar.

I If you don�t see the data directory, right-click �Folder Connections�
and click �Connect Folder...�

I Bring in the African countries polygons and the Murdock Map
polygon.
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Vector Data

Polylines

I Represent networks / routes

I Examples:

I Roads

I Rivers

I Coastlines

I Boundaries

I Bring in the boundary shape�le in ArcGis
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Vector Data

More Polygons

I Bring in the rivers and lakes shape�le
I Change the color of permanent water bodies to blue.
I Click the symbol (in this case, colored line) just below the data
name in Table of Contents

I Choose the preferred color.
I If you read the river data �rst and then the national boundary data,
the river data will be hidden below the national boundary data.

I In the Table of Contents window (the one on the left), drag the river
data and drop it above the national boundary data. Then rivers will
show up
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Vector Data

Checking Coordinate System

I We can check whether (or what) coordinate system is assigned to
each data by:

I Right-click the data

I Click �Properties...�

I Click the �Source� tab

I Scroll down to �Spatial Reference�

I If it�s not assigned yet, it says �<Unde�ned>�
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Vector Data

Assigning Coordinate System

I If you get an alert message �Unknown Spatial Reference�This
means the coordinate system is not assigned to these data.

I When the coordinate system is missing then need to de�ne it.

I Read at the documentation of spatial data you use (usually comes with
metadata that specify the coordinate system used when the data is created).

I use the De�ne Projection tool
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Vector Data

Changing Projection

I If de�ned and I want to change the projection

I for vector data, use the Project tool

I for raster data, use the Project Raster tool
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Vector Data

Remember

I You cannot overlay data with di¤erent coordinate systems

I ArcMap cannot display all the data if they are in di¤erent coordinate
systems

I To read a data with a di¤erent coordinate system, open a new map
document.
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Vector Data

What is a Map Document?

I It saves the way you overlay, color-code, & symbolize di¤erent
spatial datasets

I The �le extension is �.mxd�

I This �le DOES NOT contain spatial data. It just has links to them.

I Make sure setting the relative path to refer to each data
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Vector Data

What is a Map Document?

I Set relative paths as the default

I In the menu bar, click Customize => ArcMap Options => Check
�Make relative paths the defaults for new map documents.

I Click the save icon in the Standard Toolbar

I This icon is NOT for saving the data

I Choose the location in which you save the map document

I best to save in the parent folder for spatial data �les
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Vector Data

Point Features

I Represent point location

I Plots, Schools, Surveyed communities, Cities, Centroid of polygons

I Can be created from XY data
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Vector Data

What is XY Data?

I XY data: a table in which

I Each row: point feature

I Column 1: longitude (x value) ranges from -180 to 180.

I Column 2: latitude (y value) ranges from -90 to 90.

I Other columns: attributes of point feature (name, statistics, etc.)
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Vector Data

Read XY Data

I Read ACLED data; open excel and see the data.
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Vector Data

Point Features

I XY data format in ArcGIS: tab delimited text �le or a worksheet in
an Excel �le

I Comma delimited text �les sometimes work, sometimes don�t

I For the Stata data �le (.dta), use the "outsheet" command

I Use the "format" command so that Stata won�t round o¤ longitude
& latitude values (see Stata help format)

I If longitude and latitude are string, �rst use the "destring" command
to make them numerical
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Vector Data

Point Features

I You can create XY data on your own

I During your survey, use a GPS receiver

I If location names are available, use an online gazetteer:

I www.fallingrain.com/world

I geonames.nga.mil
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Vector Data

Model Builder

I To create a point feature class from an XY data, we will use
geoprocessing tools.

I We do this by using the Model Builder

I Model Builder helps us write a Python script (which is the coding
language for GIS)
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Vector Data

Read XY Data with Model Builder

I Convert the ACLED dataset.xlsx into a point feature class in the
shape�le format (.shp).

I Geoprocessing tools to be used:

I Data Management Tools => Layers and Table Views => Make XY
Event Layer

I Data Management Tools => Features ==> Copy Features

I Alternatively can add XY directly. By File => Add Data => Add
XY data
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Read XY Data with Model Builder

I Open a Model Builder window by clicking in the Standard Toolbar.

I In Search Window, type the name of the geoprocessing tool and
search.

I If you don�t see Search Window, click �Windows� in the menu bar.

I Drag the tool from Search Window to Model Builder

I Double-click the tool to set inputs, outputs, options etc.
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Vector Data

Read XY Data with Model Builder

I To understand what needs to be �lled in for each item:

I Click �Show Help�on the bottom right.

I Then click the item you don�t understand. The help document
appears on the right column.
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Vector Data

Read XY Data with Model Builder

I This tool (make XY data event) creates a temporary layer �le out of XY
data.

I But the layer �le often doesn�t properly work with other tools.

I We also want to save the point feature class in the disk.

I => Use the Copy Features tool to make it a shape�le data
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Vector Data

Read XY Data with Model Builder

I Input Features: the output from the Make XY Event Layer

I Output Feature Class: ***.shp

I It�s a good idea to save all the newly created spatial data in a folder
di¤erent from the one the original data is saved

I In our case, let�s save outputs in C:/warwick/
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Vector Data

Read XY Data with Model Builder

I To save the model, do the following:

I Click the save icon

I Navigate to the directory in which you will save the model

I Click the toolbox icon (red box at top-right)

I Create a new toolbox (name it, say, warwick1.tbx)

I Then click this toolbox

I Type the �le name for the model

I A model can only be saved inside a toolbox.
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Data Types in GIS

Vector Data

Save Your Work Often

I ArcGIS often crashes. It�s always a good idea to save the Model
frequently while editing it.
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Vector Data

How to use Model Builder

I To edit an existing model...

I Locate the model in Catalogue Window

I If you cannot see a folder you just created, right-click the parent
directory and �Refresh�.

I Right-click the model

I Click �Edit� (NOT �Open�)

I Now run the Model.

I Click the triangle icon at top right.

I the con�ict events across African territories should appear
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Vector Data cont.

I One more thing about vector data...

I Comes with attributes table in the dBASE format (.dbf)

I Attributes table contains �elds (i.e., variables) which can take a
di¤erent value for each feature

I To see in ArcMap, right-click the data in Table of Contents and
click �Open Attribute Table...�
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Vector Data

How to Zoom in Attributes?

I Method 1: Selection by Attributes

I In the menu bar, click �Selection => Select By Attributes�

I Select the shape �le (�name�)

I Double-click the name of a �eld based on which the selection is
conducted (�COUNTRY" in this case)

I Click �=�

I Click �Get Unique Value�

I Double-click �the country you wan to select�
I In the bottom, now you should see �COUNTRY�= �X name�
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How to Zoom in Attributes?

I Method 1 (cont.)

I Click OK. Now "country X" is selected on the map

I Right-click the shape�le (�DCW_Africa�)

I Click �Selection > Zoom To Selected Features�

I To go back to the whole world, click the Full Extent icon in the
Tools Toolbar.
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How to Zoom in Attributes?

I Now clear the selection

I In the menu bar, click �Selection > Clear Selected Features�

I If you forget doing this and conduct geoprocessing, the outputs will
be only for these selected features.
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How to Zoom in Attributes?

I Method 2: use the Zoom-In tool

I Click the Zoom-in Tool icon in the Tools Toolbar

I Drag a box that encloses the country of interest

I Play around with other tools in the Tools Toolbar
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Let�s Make a Map!

I We would like to generate a map of con�ict incidents in Zambia

I First, make a polygon shape�le with Zambia only

I Second, clip the Con�ict point �le by the Zambia polygon

I Now we have both a polygon for Zambia and the con�icts in Zambia

I Let�s distinguish between the types of con�icts
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Create Your Own Unit of Analysis

I Data Management => Feature Class => Create Fishnet

I Intersect the resulting Fishnet with the country shape�le

I this way I will have a unique cell in each country

I add coordinates as �elds to this newly constructed dataset
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Calculating Area of Polygon Features

I Let�s calculate the area of each virtual country we generated

I Change the projection of the map on the �y

I Table of Contents Window => Layers => Coordinate System => choose
projected Sinusoidal => ok

I Add �eld in the attribute Table of the "virtual" shape�le

I Right click on the new �eld and calculate geometry

I after �nishing bring the projection back to the original one
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Creating Cells within the Original Unit

Ü
Ambo Group Partitioned Between Angola and Namibia
Light Density in 2007­2008

Mean Luminosity for Ambo's partition in Angola: 0.0504

Mean Luminosity for Ambo's partition in Namibia: 0.162

Ü
Ambo Group Partitioned Between Angola and Namibia

Pixels with Zero Light Density in 07­08

Pixels with Positive Light Density in 07­08

Border Between Angola (North) and Namibia (South)
.
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Cells within Partitioned Groups

Ü
Anyi Group Partitioned Between
        Ivory Coast and Ghana

Pixels with Zero Light Density in 07­08

Pixels with Positive Light Density in 07­08

Border Between Ghana (East) and Ivory Coast (West)

Ü
Kaonde Group Partitioned
Between Zambia and Dem. Republic of Congo

Pixels with Zero Light Density in 07­08

Pixels with Positive Light Density in 07­08

Border Between Dem. Rep. of Congo (North) and Zambia (South)
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Raster Data

I Divides the earth surface into many �square� cells (or pixels)

I Each cell contains a single value

I Often created from satellite images
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Raster Data

I Examples

I Elevation, Suitability for agriculture, Population density, Forest
coverage, Nighttime light

I Can be used to assign a new variable to features in the vector data
(sse below)

I File format in ArcGIS: ESRI grid

I Some other formats (e.g., TIFF) can also be read in ArcGIS

I Geoprocessing raster datasets is quicker if in ESRI grid =) Better to
convert to ESRI grid format

I If it comes in the ASCII format (.asc), you need to convert (use the
Ascii to Raster tool)
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File Name for ESRI Grid Format

I A �le name for ESRI grid format raster cannot be longer than 13
characters.

I No extension needed
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Bring in Some Rasters

I Let�s bring in the raster �les for luminosity and agricultural suitability
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How do GIS Data Files Look Like?

I Browse the spatial data in Windows

I You see many, many �les

I Shape�le: .shp + .sbx + .sbn + .dbf + .prj

I Raster: the info folder + the data folder + .aux + .rdd + .prj

I dbf: the attributes table (dBASE format)

I prj: projection
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Use the Catalogue for Movinf Data Around

I Never use Windows Explore to browse, move, copy, or delete spatial
data

I Always use the Catalogue Window in ArcMap.
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Spatial Analyst

I How can I derive the statistics on light density, suitability for
agriculture etc.. per unit of analysis, i.e., country, homeland etc.?

I Use Spatial Analyst extension. In particular, the Zonal Statistics.

I Since we have many polygons and many raster �les it is much easier
to use model builder to automate the process.
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Spatial Analyst

I Now that we have the Tables with information on the suitability for
agriculure and light density for each polygon.

I join this information to the respective shape�le and

I generate a map of average light density across homelands.
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Useful References

I Let�s digitize a historical map!!
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Useful References

I The Yale GIS Workshops

I Dell 2009
(http://scholar.harvard.edu/�les/dell/�les/090110combined_gis_notes.pdf)

I Special thanks to Masayuki Kudamatsu
http://people.su.se/~mkuda/gis_lecture.html
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